
Tips for transitioning to form•Z 7 (from earlier versions): 
 
In formZ 7 you will find a modern interface that was first introduced in bonzai3d. 
These changes will take a little getting used to, but once you do, you should find 
that you can be much more productive with formZ 7.   
 
If you are familiar with a previous version of formZ, we would fist recommend 
going through this document to familiarize yourself with the major changes.  
Then take a look at the other resources, such as the Self Paced Tutorials, the 
online videos, and the Webinar Replays.   
 
The Self Paced Tutorials are included with the program, and can either be 
selected directly from the “Getting Started” window, or opened from the FormZ 
Folder: formZ Self Guided: ENU folder (that you copied to your Applications or 
Program Files folder). 
 
Video Tutorials can be accessed via the formZ 7: Help Menu, and can also be 
viewed online on our You Tube Channel in the formZ 7 Tutorials section: 
 
http://www.youtube.com/formz3D 
 
The Webinar Replays show a general working methodology on a variety of 
projects and also offer invaluable tips and techniques -- and can be found in 
the Demonstrations section of our You Tube Channel. 
 
So in addition to all those resources, here is a quick summary of the major 
changes that will improve your workflow and productivity: 
 
Picking (Query, Attributes, & Parameters) 
 
One of the many improvements to streamline the interface is in the area of 
Picking.  The first thing you will notice is the Selection Preview, which "semi-
highlights" objects to show what will be picked if you click. 
 
The separate Topological Levels have been automated, and the most obvious 
choice for the tool will be picked automatically.  So for example, if you have the 
Move tool active, it will move the entire object by default.  If you wish to move a 
part of an object, you can either hold down the Ctrl key (Win) or the Command 
key (Mac) and the most obvious part under the cursor will be selected, so if the 
cursor is in the middle of a face, the face will be selected, or if you are over a 
segment, the segment will be selected.   
 
You can also use the Tab key to cycle through the available options, so if the 
cursor is over the segment of a cube and you press the Tab key, the segment 



will highlight.  Press it again and the face will highlight, and press it a third time 
and the entire object will highlight.  Once the desired part is highlighted (pre-
picked), simply click the mouse to start the operation on this part. 
 
Picking Faces defaults to picking inside boundaries in the Shaded Displays, 
and picking on 2 Edges in Wire Frame.  You can change these pick modes 
separately for these display modes via the “2 Click” command from near the 
bottom of the Edit Menu. 
 
Picking multiple entities now requires the Shift key to be pressed by default.  (If 
you don't want to do this, you can change it from Edit: Preferences: Project: 
Modeling section – but try it before you change it.)  The shift picking can also be 
used in post pick modes, so you can get the Move tool, hold down the Shift key 
and click a number of objects, then release the shift key and click to start the 
move.  (In many cases where there are a few operands involved, this 
eliminates the need to pre pick the operands, which makes working faster…) 
 
Grouped objects are always picked together.  If you wish to manipulate the 
individual objects within the group, right click on a group and choose Edit 
Group.  While editing a group, the rest of the objects in the file will be Ghosted.  
(Make sure Hide Ghosted is not selected from the Display Options if you wish 
to see these.)  You can also enable the Snap to Ghosted objects option (from 
the Palettes Menu: Snap Options: Object tab) if you want to manipulate objects 
in a group relative to other objects that are not in the group.  Right click once 
more and select Edit Group Complete when you are finished.  (The same 
applies to editing Components -- but more on this later.)  There is also an 
Unlock Groups command available from the Edit Menu that will ignore the 
grouping structure, and simply pick objects. 
 
Pick Filters will select only objects that a particular tool can use.  Therefore, if 
you have the Join Lines tool active, you can Select All, and only the open lines in 
the project will be selected – or if you get the Explode Components tool and 
Select All, all of the Components in the project will be selected.  Similarly, the 
Sweep and Revolve tools only work on Segments and Faces, so if you have 
one of these tools active and you put the cursor on an edge, the segment will 
be picked, and if you move it inside a face, then the face will be selected. 
 
In addition to the automatic picking that is available with the Pick Tool, it is also 
possible to choose specific topological levels if you like (but once you get used 
to the auto-picking, we suspect that you will use the topo levels less and less). 
 
The Pick tool can also Area Pick by clicking in a blank area of the screen, and 
dragging to frame a rectangular area.  There are options to control whether the 
Frame will pick Inside, Crossing, or a combination (based on the direction in 
which the frame is drawn).  There is also an Area Pick tool that will never pick 
objects directly (which is useful when area picking inside a complex scene) 



and the Area Pick also has options for custom shaped selection areas. 
 
The Select By command (previously from the Edit Menu) is now available as the 
Selection By Criteria Palette, and there is also a Selection Set Palette that can 
save sets of objects if they frequently need to be selected together in the future. 
 
Click and Dragging of objects with the Pick tool are now the default, and there 
are Pick Options for enabling or disabling this if you like. 
 
The Query Object, Query Parameters, and Query Attributes functions have been 
incorporated into the Pick Tool Options.  Just select the desired object(s), click 
the appropriate tab, and change the options to update the objects immediately.  
Note that on the Attributes Tab, there is a menu that is set to Basic by default, 
but this can be changed to allow access to Display Resolution, Smooth 
Shading, and other settings. 
 
Changing Layers of objects can also be accomplished via the Pick Tool 
Options: Attributes Tab.  Simply select any objects, and change the layer status 
to immediately move these objects to that layer (or you can use the Set Layer 
tool from the attributes tool row). 
 
Guides and Snapping improvements 
 
Automatic Guides are generated as you are working and drawing, and by 
default you will snap to these guides.  You can toggle the snapping to these 
guides, or to parts of objects via the Snaps Palette at the bottom of the screen.  
The Guides will automatically be generated orthogonally from the current point.  
Thus these guides replace the Ortho Snap, as simply snapping to these 
guides will achieve the same result.  Additionally, when the cursor is over a 
guide, you can hold the Shift key and move the cursor off the guide, and the 
cursor will be locked to the guide – which can be useful if you need to snap to, 
or reference something that is away from the guide. 
 
The Perpendicular to Reference Plane command will be toggled by tapping the 
Command key (Mac) or Ctrl key (Win) when moving or drawing. 
 
Temporary Snap Guides can be created by pressing the Shift-Spacebar 
shortcut when the cursor is in the desired location when a move or draw tool is 
active.  This can occur before or during the creation of objects, and a total of 3 
Temporary Guides can be created simultaneously.  (When a fourth temporary 
guide is created, the first one is automatically removed.)  The Ctrl (Win) or 
Command key in addition to the Shift-Spacebar command will automatically 
delete all temporary guides. 
 
Permanent Guides can also be created using the Draw Guide tool from the 



upper right tool row of the Modeling Tools.  Permanent Guides will be placed 
on the active layer and can manipulated (moved, rotated, etc) just like any other 
object.  You may want to keep your guides on their own layer so they can easily 
be turned on or off – or deleted.  (Since guides extend infinitely, you can also 
zoom out and pick these with the Pick Crossing option if you want to delete 
them or change their layer.)  
 
The Grid Snap (located at the bottom of the screen) also includes an Angle 
Snap that will take effect whenever operations that includes angles are 
involved. 
 
Draw on Surfaces  
 
When drawing, a reference plane is automatically generated on faces of 
objects at the location of the cursor, so if you draw one cube, you can easily 
draw another cube on the top or side face of this cube by simply placing the 
cursor in this location and starting to draw.  If you enable the Insert Option, then 
the object that is drawn will automatically be Booleaned with the original object, 
allowing you to easily add to or subtract from the original form. 
 
Note that the Draw On Surfaces mode only applies when drawing in the 
Shaded modes, and does not apply when working in Wire Frame.  Draw on 
Surfaces will also be disabled if you click the Lock Plane icon at the bottom of 
the screen, or if you press its key shortcut (F5). 
 
Numeric Input  
 
The Prompts Palette has been separated into two individual palettes that are 
both contained in the Tool Dock at the upper left corner of the screen.  The 
Action Palette prompts the user for the expected operations and offers tips for 
key shortcut options available for the active tool, while the Input Palette tracks 
the location of the cursor, and allows objects to be created or manipulated 
numerically.   
 
To the right of these fields is a menu that allows you to toggle the input from 3D 
to Delta, which then interprets the numbers relative to a previous point 
(equivalent to unchecking the A checkbox in the prompts palette).  To the right of 
this will be additional fields, such as length and width, or distance and angle 
while you are drawing or transforming objects. 
 
Pressing the F4 key will automatically set the location of the curser to 0,0,0, and 
switch the input mode to 3D Delta, which makes relative transformations quick 
and easy.  Also, when drawing vector lines, you can just move the cursor in the 
desired direction and enter the distance if you want.  If you Tab to the next field, 



this value will be “locked” and you can then move the cursor around the screen 
 
 
Watch the hints in the Action Palette for "step by step" prompting. There are 
many useful keyboard modifier keys that will be listed, such as: use the 
Command or Ctrl key while drawing to change the draw direction of an arc, 
tapping Shift to toggle Insert on and off, or other shortcuts to end or close the 
line. 
 
Result Buffer & Edit Controls 
 
Many tools allow you to change options while the object is being created, and 
immediately after it is created (while it is orange, indicating that it is still in the 
Result Buffer).  For example, click on a source shape with the Revolve tool, and 
then click on an axis.  While the object is still orange, you can change the 
revolution angle, direction, resolution, etc.  You can also change many options 
(such as the extrusion type, the copy options, etc) while you are drawing or 
moving objects to adjust the results without needing to start over. 
 
Objects that have just been created will show their controls automatically, 
allowing easy modification if desired.  You can also adjust any of the Tool 
Options, and the object will update automatically.  (These controls will 
automatically disappear when the next object is created, or the next tool is 
selected.  You can also press the ESC key to drop these controls if you need to 
create another object with the same tool in the same location.) 
 
To Edit a controlled object later:  With the Pick tool or any Transform tool active, 
simply right click on the object  and choose Show Controls.  You can adjust 
these controls with any of the Transform tools (ie, Move, Rotate, Scale) and you 
can also drag these controls with the Pick tool.  (Right click again and choose 
Hide Controls to complete the editing operation.)  These controls can also be 
accessed by selecting the object(s) and pressing the F6 key shortcut to toggle 
the visibility of the controls. 
 
To Edit a controlled objects parameters numerically, either right click the object 
with the Pick tool and choose Parameters, or pick the object and click the 
Parameters Tab of the Pick Tool Options.  (Many objects with similar 
parameters can be manipulated at the same time with either method, but if you 
have dissimilar objects such as an extrusion and a revolve, the Parameters will 
not be available.) 
 
Status of Operands (automatic) 
 
The Status of Operands is now handled automatically, and for some 



operations, they will be kept, while for others, they will be ghosted or deleted. If 
you want manual control over your operands, use the desired setting as well as 
the Apply to All Operands from the Edit Menu. 
 
formZ will automatically check to see if your file is accumulating a lot of  
ghosted operands, and if so, it will give you a warning and allow you to always 
keep or always delete these when you save the file.  (If you choose "Always" 
and you want to change this later, you can do so via the File Menu: Project 
Settings: Project File tab.  Note also that if you choose to delete these ghosted 
objects, they will not be deleted from the currently open project, but they will be 
omitted from the file that is saved.) 
 
Extrusion and Copy Modifiers 
 
The Extrusion and Copy Modifiers are now part of the tool Options for tools 
where they apply.  Pressing the Alt key (Win) or Option key (Mac) will toggle 
through the Extrusion Options -- and will also toggle back and forth between the 
Self and the last used Copy modifier. 
 
Favorite Tools – Heads up Display 
 
The "Favorite Tools" feature offers a "heads up display" that appears when you 
press the Space Bar.   These favorite tools can be customized via the bottom 
portion of the Tool Manager, and they also provide quick access to the last 4 
tools that were used. 
 
While this Favorite Tools display is visible, you can also press the first letter of 
any tool and a complete list of all tools that start with that letter will be 
presented.  Clicking on the desired tool will then make it both active – and 
reveal the tool in the tool palette. 
 
Favorite Tools can be customized via the Tool Manager.  (See below.) 
 
Tool Manager (Customize Tools) 
 
The Tool Manager command (from the bottom of the Workspace Menu) 
enables a special mode, and while this palette is open, tools can be added, 
removed, or repositioned from within the tool palettes, and new custom 
toolbars can be created.  You can drag the tools from the Tool Manager into 
these custom toolbars, and you can also add, remove, or relocate tools from 
the main tool bar.  
 
By right clicking on the tool bar or the torn off tool palettes while the Tool 



Manager is active, you can select Settings and control the size of the icons, and 
whether or not it will show the names of the tools. 
 
The Tool Manager also allows customization of the Favorite Tools by simply 
dragging the icon from within the Tool Manager to the Favorites section below. 
 
When you are finished customizing, this palette must be closed before you 
continue working on a project. 
 
Context Menus 
 
Right Click Context Menus offer context sensitive functionality.  For example, 
with the Pick tool, you can right click on an object, and the menu that appears 
will allow you to access its Attributes, Info, Parameters, Show Controls, and 
even select additional objects that share the same layer or same color.   
 
While right clicking in Palettes, you can access items related to that portion of 
the palette.  For example, if you right click on the Visible column, you can make 
all visible or invisible, if you right click on the Locked column, you can make all 
locked or unlocked, and if you right click in the main portion of the palette, other 
options are available. 
 
(If you don’t have a mouse with a scroll wheel and a right click – get one!) 
 
Windows "Option" key (ALT replaces Ctrl-Shift) 
 
With previous versions of formZ on Windows, the Ctrl-Shift keys were the 
equivalent of the Option key on the Mac.  This has now changed to the ALT key 
(so that only a single key is necessary). 
 
Components 
 
Components (which replace both Clones and Symbols) are actually separate 
FMZ files that are embedded within the project file, and are created or placed 
with the Create Component and Place Component tools. Choose the 
Embedded library from the Component Manager: Library Menu to see which 
components exist in the current project file.  (Symbols will automatically be 
converted to Components if a FMZ file that contains Symbols is opened…)   
 
To Edit Components, simply right click on them with the Pick Tool and select 
Edit Component.  (You may want  to uncheck the Hide Ghosted and check the 
Snap to Ghosted options to edit these components relative to other objects in 
your scene.)  You can also right click Components from the Component Palette 
and select Open to modify the Component in a separate file. 



 
If you pick one or more Components, you can see which Components are 
selected in the Parameters Tab of the Pick Options, and you can drag a new 
Component from the Components Palette onto the Selected Component icon 
to replace it.  There is also a Replace Component Tool that replaces the 
currently selected Components with the Active Component in the Component 
Manager 
 
The Component Management options are located at the bottom of the 
Component Palette, where you can Import files and turn them into Components 
directly, Convert Symbol Libraries to Component Libraries, and add folders of 
formZ files to automatically add them to your Component Libraries.  
 
An Unlock Components command is also available from the Edit Menu.  When 
this option is selected, you can work directly on the objects within components, 
and when you make changes, a dialog will appear that will allow you to 
automatically create a unique component – or to update all identical 
components in the project with the same changes.  (There are also options 
available to always update, and don’t show that message if you like.) 
 
Sections and Clipping Planes 
 
The Section tool now works directly – or interactively.  With the Dynamic option 
selected in the Tool Options, Section Planes can be moved and rotated while 
the objects are being sectioned with both 2d and 3d sections, and real time 
Booleans are calculated. 
 
Clipping Planes are non-destructive sections, which clip the view of the objects, 
but not the actual objects themselves.  They can be edited like the sections, 
and by right clicking on a Clipping Plane, you can choose Make Permanent if 
you really want to cut the geometry. 
 
Display Modes (Shaded Work) 
 
The Default display mode is Shaded Work, which is an OpenGL display mode 
that has a "head lamp" light source so your objects are always illuminated, 
regardless of where you are looking.  This mode also has a Draw on Surfaces 
feature that automatically detects the closest surface under the cursor when a 
drawing tool is active and creates an arbitrary plane.   (Draw on Surface only 
applies to the Shaded modes, and this feature is disabled when using Wire 
Frame mode. Also, make sure that the current Reference Plane is not Locked if 
you wish to use this feature.)    
 
Shaded Full is an OpenGL display mode that will use whatever lights are 



shining in the scene.  Check the Accurate Shadows for better illumination if 
more than one light is casting shadows. 
 
RenderZone is now available as an Optional Plugin, which is registered 
automatically with the Beta version.  The Set Image Size feature has now been 
updated to the Display Menu: Render Area Rectangle command, which allows 
you to define an area of the screen to be rendered if you don't want to render the 
entire window.  (If you do not see RenderZone as an option in the Display 
Menu, the plugin has been disabled, and you can enable it once more by going 
to the Extensions Menu: Extensions Manager, scrolling to the bottom of the list, 
checking it, and relauching formZ.) 
 
The Display Options Palette allows you to access all the options from all the 
display modes.  Once you have chosen the desired settings, you can then 
press the Render button at the top right to switch to this display mode.  
Alternately, as you change display modes (either via the Display Menu, or the 
display icons at the top of the screen) the palette will automatically present the 
options for the current mode so you can make any necessary adjustments.  
And if you have the Automatic box checked, then changes made to the current 
display mode will be updated immediately.  Otherwise you can press the 
Update button from the bottom of the Display Options Palette.  
 
Reshaping  
 
The Reshape Tool allows 2d surfaces to be transformed into 3d objects, as 
well as faces of 3d objects to be moved perpendicular to the surface, or 
reference plane.  (If the object does not have a surface, it can not be reshaped, 
but it can be extruded using the derivative tools.)  If one face is moved so that it 
intersects another face of the same object, real time Booleans are 
automatically performed to ensure clean geometry.  The Keep Edges option 
also allows you to reshape outward without eliminating the original edges, 
which provides powerful sculpting capabilities (and can be a lot of fun too). 
 
(If the Reshaping is not working, make sure that you have not locked the 
reference planes – and that you are not using the 2 click face pick option (from 
the Edit Menu).  If it is still not working, check your geometry for problems using 
the Object Doctor (from the Measure tool row).) 
 
Offsetting & Imprinting 
 
The Offset tools are located on the Reshape Tool Row, and are very useful for 
offsetting an edge or outline of an object -- that can then be reshaped in or out 
of the object to quickly sculpt the geometry.  This process can be seen in detail 
on the Sketch Example Webinar Replay that can be found here:  



http://www.formz.com/webinars/webinars_html/arch_explore.html   
 
Imprinting allows you to "insert" existing curves onto a surface (providing that 
these curves are coincident with that surface). 
 
Performance 
 
Many improvements to the modeling and redraw performance have been 
added.  Here are a few tips that you can do to speed things up further: 
 
When Importing CAD drawings for reference, check the Make Reference Object 
option.  This will effectively Join all the objects together, greatly reducing the 
overhead, but still allowing you to snap to individual parts.  There is also a Per 
Layer option that will create a separate object for each layer in the file.  If you 
need to use some parts of a Reference Object directly, click on it with the 
Separate tool to convert it back to individual objects. 
 
The Shaded Work and Shaded Full Display Option to show Silhouette Edges 
can be computationally intensive for complex files, so uncheck this option if you 
need to further improve the performance with a large file. 
 
formZ 7 also uses many modern OpenGL commands, so having the latest 
video driver will help with performance, and perhaps with stability as well.  On a 
Mac, simply keep your operating system up to date with the Software Update 
command.  On Windows, download the current driver from the web site of the 
manufacturer of video card, Uninstall the existing driver from the Programs 
Control Panel, reboot, (cancel the hardware found wizard if it appears) and then 
install the current driver. 
 
Reference Planes and Underlays 
 
Reference Planes will be automatically generated based on the face beneath 
the cursor when drawing or moving in a Shaded mode (as noted earlier in the 
Draw on Surfaces section).  The Reference Plane can also be locked by 
pressing the F5 key to prevent it from changing as you are drawing.   Reference 
planes can further edited graphically using the Edit Reference Plane tool, which 
is located by default at the bottom of the screen. 
 
Underlays can be associated with any saved reference plane.  Just right click 
the desired reference plane from the Planes Palette, select Edit, check Image, 
and Load your image.  The Underlay will automatically be sized to the extents of 
the plane, which can be set numerically (via the Reference Plane Parameters), 
or graphically using the Edit Plane tool (located in the Reference Plane Tools 
Palette at the bottom of the screen).  Changing the size or orientation of the 



plane will then adjust the size and location of the Underlay Image.  Underlays 
can also resized using the Measure Distance Tool.  Just check the Underlay 
option from the tool options, click two points on the underlay – and the current 
size will be shown.  Enter the desired distance in the Tool Option Palette, press 
Tab or Return, and the Underlay will automatically be scaled accordingly. 
 
When drawing with an underlay, it is often useful to Lock the reference plane 
using the F5 key so the planes don’t change (and the Underlay does not 
disappear). 
 
Another way to use images as a reference is to simply map the image onto a 
rectangle.  The Billboard Tool (from the Primitives tool row) will automatically 
map an image to fit a rectangle as it is created, streamlining this process. 
 
Colors and Textures 
 
Materials (formerly Surface Styles) now have multiple types including Shaded 
and RenderZone (and potentially other types if you have additional rendering 
plugins installed).  These types can be selected from the menu at the upper 
right corner of the Material Parameters Palette, which can be invoked by double 
clicking on the desired Material.  Materials also contain a Default Texture size 
that will automatically be assigned to objects when they are created using that 
material. 
 
Objects can be colored using the Paint Tool, or by dragging the desired 
material from the Palette onto objects, either in the screen, or in the objects 
palette.  You can also select objects, click the Attributes Tab of the Pick Options, 
and change the color from there.  NOTE that with the Paint tool, you have the 
option to automatically apply the Default Texture Size for a given material, or if 
you uncheck this option, then the existing mapping on the object will be 
maintained. 
 
The most appropriate texture mapping type is automatically applied to an object 
as it is created.   For Example, a cylinder (or other circular type objects) will 
automatically get a cylindrical mapping on the curved surface, and a flat map on 
the top.  If you want to change or otherwise adjust this, you can do this with the 
Map Texture and Edit Texture tools from the Attributes tool set (which can be 
applied to entire Object or their Faces). 
 
Materials also have a Default Texture Size, which is automatically applied to the 
objects when they are created with that specific Material.  (This texture size is 
not changed if materials are changed unless you are using the Paint tool with 
the Apply Default Texture Size option.  Otherwise, this only applies at the time 
objects are created.) 
 



To create a Texture Group, select the desired face(s), get the Map Texture tool, 
set the Mapping type to anything other than Best Match, and click in the screen.  
Then you can use the Edit Texture tool to size these faces independently from 
the rest of the object if you like. 
 
(In many cases the new texturing is vastly superior to the previous methods – 
but there are a few cases where the old texturing methods could still be useful.  
Therefore the old style texture map dialog will be restored at some point in the 
not too distant future…) 
 
Objects are also generated with a black edge color by default.  If you wish to 
change this for an existing object, you can do this via the (Basic) Attributes Tab 
of the Pick Options for any selected objects.  If you wish to change this for all 
future objects, you can also set this in the File Menu: Project Settings: Objects 
Tab. 
 
Project Settings and Working Units 
 
The Project Settings command from the File Menu allows you to customize the 
appearance of your project (such as the background color), as well as control 
what Working Units are used and how they are displayed. 
 
Workspaces 
 
Different main functions such as Modeling, Drafting, Rendering and Animation 
have been separated into different Workspaces.  You can change between 
these different workspaces via the Workspace Menu.  The Workspace Palette 
(located by default at the top of the Palette Dock) can also be used for quickly 
switching workspaces. 
 
Preferences 
 
By Default, Preferences are now automatically saved from the previous 
session.  If you like, you can still choose to use a specific preference file, and 
you can also choose to always update this preference file -- or never update the 
preference file (or have it ask you each time).  Basic settings in the preferences 
are also saved automatically, and no longer require you to resave the 
preference file to retain these settings for the next session. 
 
Isolate & Reveal 
 
Picked objects can be isolated by right clicking on them with the Pick tool and 



selecting Isolate Objects from the context menu (which can be particularly 
useful when working with complex files).  When you are finished with any 
changes, right click on the objects again with the Pick tool and choose Reveal 
Objects to restore the rest of the project. 
 
Views and Navigation: 
 
Zooming with the Scroll wheel has changed a bit with version 7, and how far it 
zooms is determined by the length of the line of site (which is the distance 
between the eye point and the center of interest for the active view -- whose 
values you can see in the View Parameters Palette).  
 
When simply zooming with the Scroll wheel alone, the eye point is moved closer 
and closer to the center of interest, and the percentage for this movement is 
controlled by the Zoom Options (palette): Zoom In By value. Thus, as you get 
closer and closer to the center of interest, you will notice that the zooming gets 
slower and slower.  
 
If you hold down the Alt while zooming, then this will move the entire camera 
forwards, and the rate of zooming (also controlled by the Zoom In value) will be 
constant (since the distance between the eye point and center of interest is not 
changing).  
 
So to get better control over the zooming, set the Center of Interest on or near 
the desired zoom location. One way to do this is to use the Fit command -- and if 
you pick any objects and execute the (Command F) key shortcut, the picked 
objects will be fit -- and the center of interest will automatically be centered these 
objects. You can also try setting a smaller zoom in by percentage (closer to 
100%) to reduce the zoom speed if you like. 
 
Match View 
 
A new Match View tool has been added, which makes accurately matching the 
view with a background image a snap.  To use this tool, first go to the Shaded 
Work Display Options and set the Background Options to Flat Image.  Click the 
image icon and load in your desired image.  Next, get the Match View tool (from 
the top of the screen, just below the display mode icons, next to Fit), snap to a 
point on your object, and click on the associated part of the image.  (Note that 
the Tool Options Palette gives you a zoomed in view so you can align this 
accurately.)  Add a few more lines connecting points on the geometry to points 
in the image and click the Solve button to align the views.  If the view does not 
match properly, you can pan or set view to find additional points to match to 
their pixels, and existing points can be adjusted as necessary to perfectly align 
the view. 
 



The Wireframe Display does not (yet) have a Background Image option, so if 
you see through your objects in the Shaded Display, you can select your 
objects, and (temporarily) uncheck Render as Shaded from the Pick Options: 
Attributes Tab. 
 
Preview Dialogs (mostly gone) 
 
Preview Dialogs have virtually been eliminated, and most tools have editing 
controls directly in the modeling window (the Edit Textures and Revolve tools 
are examples).   
 
 
 
 
Hopefully this guide has been useful for getting acquainted with the major 
changes with formZ 7.  Please also view the videos and webinar replays for 
more information, and let us know if you have any further questions. 
 
Happy Modeling! 
 
The formZ 7 Team 


